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Master	PDF	Editor	is	simple	application,	easy	to	use	to	work	with	PDF	documents	equipped	with	powerful	multifunction	feature.	With	Master	PDF	Editor	you	can	easily	view,	create	and	edit	PDF	documents.	The	application	allows	you	to	combine	several	files	in	one,	divide	a	source	document	into	multiple	documents,	and	also	to	comment,	sign	and
encrypt	PDF	files.	Buy	(Create,	Edit,	Signal,	OCR	and	PDF	Print	DocumentsModify	Text	and	ObjectSwith	Master	PDF	Editor	You	can	add	text	with	any	formatting	to	a	PDF	document	or	change	the	existing	text.	You	can	also	insert	images	on	the	document,	select	and	move	objects	,	change	the	size	of	the	objects,	save	the	images	in	a	file	and	copy
objects	to	the	clipboard.	Powerful	annotation	tools	as	a	sticky	note,	measuring	instruments	and	shapes,	as	well	as	the	advanced	modification	features	provided	by	Strikethrough,	from	underline	and	from	Highlight	functions	will	make	your	work	easier	than	ever.	Create	unique	stamps	and	use	them	when	examining	the	document	or	make	a	note	of	your
state.Create	and	fill	out	the	PDF	FormSwith	Master	PDF	Editor	is	very	easy	to	change	the	various	elements	of	PDF	modules	interactive	as	buttons,	text	fields,	check	boxes	and	more,	as	well	as	event	managers	d	Ell'Attrozzo	for	predefined	user	actions.	The	automatic	calculation	and	data	validation	with	JavaScript	are	supported.	The	recognition	of	the
character	-optic	recognition	of	the	recognition	character	allows	you	to	search	for	text	quickly	and	efficiently,	as	well	as	to	modify	documents	and	documents	scanned	containing	images.	Leopulations	on	PDF	PagesMaster	PDF	Editor	supports	both	the	merger	and	cutting	pdf	files.	Allows	you	to	move,	remove,	insert	and	easily	rotate	the	pages	in	PDF
documents	and	change	their	size.PDF	BookmarkScreate,	modify	and	remove	bookmarks.	Add	Bookmarks	for	specified	pages	or	paragraphs	to	allow	quick	documents	to	navigate	and	search	for	information	efficiently.	PDF	PDF	PrinterMaster	PDF	Editor	is	installed	as	a	virtual	PDF	printer,	allowing	you	to	easily	print	any	document	from	different
applications	that	support	printing	(and	Microsoft	Word	/	Excel,	OpenOffice).	*	The	virtual	PDF	printer	is	included	only	in	the	Windows.Check	digital	signature	version,	create	new	and	sign	documents	with	the	digital	certificate.	For	PDF	documents,	a	digital	signature	is	the	equivalent	of	the	handwritten	signature	on	paper	documents,	so	the	recipient
of	the	signed	document	could	be	sure	of	its	authenticity.	*	In	order	to	use	this	feature	you	need	a	digital	signature	certificate.	Create	PDFPDF	documents	can	be	created	directly	from	paper	documents	using	a	scanner.	Master	PDF	Editor	allows	you	to	create	documents	from	Existing,	create	empty	documents	or	insert	blank	pages	into	an	existing
document.	The	demo	version	allows	you	to	try	all	the	functionality	of	the	Master	PDF	Editor.	There	are	no	limitations	except	adding	a	watermark	to	the	output	file.	Many	of	us	may	not	familiarize	with	Audio	Reader.	This	is	a	text	for	an	audio	program	that	allows	you	to	read	your	PDF	text	aloud.	In	this	article,	we	will	introduce	several	popular	PDF
audio	player	tools	for	Mac,	Windows,	iPhone	/	iPad	and	Android,	which	will	help	you	learn	how	to	choose	the	best	PDF	file	reader	for	your	needs.	If	you	need	a	PDF	editor	to	edit	PDF,	convert	PDF	to	Excel,	Word,	PPT,	etc.,	PDFelement	Pro	is	a	robust	solution	for	PDF.	Here	is	a	free	trial	version,	you	can	download	it	to	test.	Part	1:	What	is	PDF	Audio
Reader?	A	PDF	audio	player,	on	the	other	hand,	is	a	text	for	voice	software	(TTS.)	Its	primary	purpose	is	to	convert	text	into	audio.	In	other	words,	it	reads	the	text	aloud.	More	PDF	audio	readers	have	the	ability	to	read	not	only	PDF	files,	but	also	Word	and	Web	(HTML,)	Kindle	and	other	text	file	formats.	Initially,	the	software	was	created	to	assist
visual	problems,	but	now	all	users	can	take	advantage	of	the	software.	Many	are	trying	to	avoid	eye	forming	as	in	the	case	of	writers	who	reproduce	their	work.	They	use	TTS	software	to	read	their	work	again	to	them	so	that	they	can	take	a	small	pause	from	setting	on	the	computer	screen.	In	other	applications,	usually	in	mobile	devices	such	as
smartphones	and	tablets,	TTS	Apps	are	used	to	convert	important	text	messages	and	/	or	e-mail	to	talk	when	the	user	is	doing	something	that	occupies	their	hands	and	eyes,	like	the	Guide	for	example.	The	others	simply	love	to	relax	and	listen	to	the	audio	conversion	of	an	e-book	or	long	article	instead	of	actually	reading	the	text.	Part	2:	PDF	audio
player	for	computer	users	or	mobile	users	#	1:	Text2Speech	(Mac)	TEXT2	Speech	is	one	of	the	best	PDF	audio	players	that	can	be	used	with	Mac.	It	can	be	downloaded	from	the	Apple	App	Store	and	for	further	functionality,	You	can	buy	or	update	the	Text2Speech	Pro	paid	version.	This	TTS	is	supplied	with	10	entries,	but	if	you	run	OS	X	Lion	10.7,
you	will	give	you	the	possibility	of	downloading	additional	items	from	iTunes.	Mac	devices	running	OS	X	Lion	can	also	download	updates	to	support	26	additional	languages.	Speech	text	also	has	a	version	of	Windows.	#	2:	Ghostreader	(Mac)	Ghostreader	is	the	Mac	version	of	the	PDF	audio	player.	It	has	almost	the	same	features	as	its	Windows
counterpart,	but	includes	the	ability	of	Bookmark	Audiobooks	from	your	converted	PDF	e-books,	a	feature	not	found	on	the	converted	files	of	other	converters.	The	negative	side	of	this	software	is	that	it	can	be	a	bit	expensive,	but	you	can	add	additional	items.	A	phantom	reader	just	purchased	can	have	up	to	20	license	credits	for	the	purchase	of
additional	entries.	#	3:	Natural	Reader	(Windows,	Mac	and	Online)	Natural	Reader	is	a	Text	to	Speech	download	software	available	in	and	Mac	and	also	offers	a	paid	version	with	additional	features.	It	is	also	a	PDF	voice	reader	online.	This	software	allows	you	to	check	the	speed	speed	and	allows	you	to	customize	the	items.	This	version	has	only	a
female	voice;	The	paid	version	has	more	vocal	choices	and	the	option	option	save	the	converted	text	as	mp3,	wav,	wma	and	other	types	of	audio	files.	natural	reader	can	open	and	convert	word,	pdf,	powerpoint	and	more	and	if	the	file	is	in	an	unsupported	format	it	is	always	possible	to	copy	and	paste	the	text	into	the	area	and	the	software	can	convert
it	from	there.	However,	you	convert	the	text	into	segments	and	during	the	transition	between	segments,	words	tend	to	get	either	mumbled	or	jumped.	#4:	balabolka	(windows)	balabolka	is	a	pdf	free	speech	reader	based	on	windows,	and	since	it	uses	windows	components,	it	is	not	designed	to	work	on	a	mac.	uses	api4	files	of	microsoft	speech	to
synthesize	the	speech.	microsoft	sapi	is	usually	bundled	with	windows,	but	if	it	cannot	be	easily	downloaded.	balabolka	is	able	to	read	pdf,	doc,	rtf,	html	and	more.	for	unsupported	formats,	you	can	still	copy	and	paste	the	text	directly	to	the	balabolka	window.	saves	the	converted	file	into	a	variety	of	formats	including	mp3,	wav,	wma	and	others.
balabolka	is	also	highly	customizable.	you	can	edit	the	skins	and	has	the	ability	to	download	multiple	items	online.	#5:	dspeech	(windows)	dspeech	is	also	a	pdf	audio	player	per	pc	that	has	all	read	and	save	standard	functions	of	text	converters	up	and	more.	its	support	goes	up	to	provide	links	where	you	can	download	or	buy	additional	items.	dspeech
also	uses	soaps	and	other	windows	components,	so	it	is	lightweight	to	download.	what	makes	this	unique	is	that	it	can	reverse	the	process;	has	a	voice	recognition	function	in	which	it	can	convert	the	captured	voice	of	the	user	to	text.	dspeech	also	has	an	open	source	multilanguage	update	where	you	can	download	additional	code	to	allow	you	to
correctly	read	other	languages	including	German,	French,	Japanese	and	Chinese,	among	others,	you	can	visit	their	website	for	the	complete	list.	the	only	problem	with	dspeech	is	that	it	has	conversion	speed	problems	and	sometimes	cannot	collect	on	context.	#6:	svox	pico	(android)	svox	pico	is	a	version	of	svox	and	is	often	bundled	with	buying	an
android	device.	the	tts	is	quite	functional	but	has	one	of	the	most	robotic	voices.	a	user	needs	to	switch	to	the	classic	svox	to	access	other	paid	items.	#7:	voice	dream	(mac)	voice	dream	is	a	lighter	version	of	an	audible	pdf	reader	for	mac.	Despite	the	light	is	still	full	of	features	and	still	boasts	the	same	clean	and	easy	to	hide	interface.	some	of	its
important	features	include	bookmarks	for	long	documents	and	note	grip	capabilities.	Unlike	the	mac	version,	however,	it	does	not	have	the	option	copy	/	paste	(bed	clipboard)	for	unsupported	formats.	voice	dream	is	optimized	for	both	iPhone	and	iPad.	#8:	web	reader	(web	extension)	the	web	reader	app	is	an	iphone	tts	app	optimized	for	reading	web
content	like	web	pages,Blog	posts	and	social	networks,	and	text	files	similar	online.	Web	Reader's	Standout	Features	include	its	image	lock	function	to	allow	written	content	to	load	fastest	quickly	Car	talking	from	the	background	when	multitasking.	The	web	reader	also	works	well	with	local	synchronization	applications	like	Dropbox.	The	negative	side
with	this	app	is	that	it	is	an	iPhone	only	app	and	its	features	are	more	concentrated	on	online	than	offline	functions.	Part	3:	The	best	software	for	PDF	solution	-	PDFelement	Pro	in	terms	of	text	in	PDF	format,	PDFelement	is	excellent	software	for	PDF	audio	players.	But	it's	not	just	a	software	for	PDF	audio	players,	but	also	a	perfect	software	for	the
PDF	solution.	You	can	have	a	lot	of	requirements	like	to	edit	PDFs,	convert	PDF	to	Excel,	Word,	PPT,	etc.	Everyone	can	be	satisfied	by	PDFelement.	Just	try	the	free	version	before	buying,	you	can	find	out	that	this	is	a	great	alternative	Adobe	Acrobat.	1	Open	your	PDF	in	Acrobat	Reader.	You	can	open	the	PDF	in	Acrobat	Reader	by	clicking	File>	Open
or	right-click	the	file	in	a	file	browser	and	select	Open	with>	Adobe	Acrobat	Reader.	Adobe	Acrobat	Reader	DC	is	a	free	Adobe	PDF	viewer	that	works	with	Windows	and	Mac.	If	the	PDF	from	which	you	want	to	copy	has	been	created	by	a	text	document	to	a	computer,	you	may	be	able	to	select	and	copy	the	text	into	the	PDF	from	here.	If	the	PDF	from
which	you	want	to	copy	has	been	scanned,	you	will	not	be	able	to	use	this	method.	If	you	don't	have	Adobe	Reader	yet,	you	can	download	it	and	install	it	for	free.	2	Select	the	text	in	the	document.	You	can	do	this	by	clicking	the	Edit	tab	on	the	upper	left	side	of	the	Acrobat	Reader	(Windows)	window	or	in	the	upper	left	side	of	the	screen	(Mac),	and
select	everything	from	the	drop-down	menu.	If	you	want	to	select	a	specific	text,	you	can	drag	and	release	the	mouse	to	the	text	you	want	to	highlight	in	blue.	You	can	also	use	the	keyboard	shortcut	and	press	Ctrl	+	A	(Windows)	or	CMD	+	C	(Mac).	If	the	entire	document	is	highlighted	in	blue,	the	document	cannot	be	copied	and	glued	as	text.	Instead
you	will	need	to	use	Google	Drive.	3	received.	Click	the	Edit	tab	again,	then	click	Copy	or	use	the	keyboard	connection	and	press	Ctrl	+	C	(Windows)	or	CMD	+	C	(Mac).	If	your	PDF	is	longer	than	a	page,	you	will	have	to	go	back	and	copy	the	other	pages	individually	after	having	glued	the	contents	of	this	page.	4	Open	a	new	document	in	Word.	When
you	open	Word,	you	will	be	asked	if	you	want	to	open	a	new	document	or	resume	one	created	above,	click	to	open	a	new	document.	You	can	also	go	to	File>	New.	5	Paste	the	copied	text.	Press	Ctrl	+	V	(Windows)	or	CMD	+	V	(Mac)	or	go	to	the	editing	menu	and	click	Edit>	Paste.	You	should	see	the	text	from	the	PDF	appear	in	the	document.	You	can
also	right-click	the	page	and	click	Paste	in	the	drop-down	menu.	1	Open	your	PDF	in	Preview.	This	application	icon	looks	like	an	image	with	a	magnifying	glass	above	it.	You	can	find	this	application	in	the	Dock	or	in	the	Applications	folder.	You	can	open	your	PDF	from	Preview	by	clicking	File	>	Open	or	right-click	the	file	and	select	Open	with	and
Preview.	Preview	is	the	default	PDF	viewer	for	Mac,	so	if	you	use	a	Windows	computer,	you	willProbably	won't	have	access	to	Preview.	2	Click	the	text	selection	button.	This	looks	like	"Aa"	with	a	cursor	next	to	it.	This	should	be	above	the	document	on	the	left	side	of	the	window.	3	Select	the	text	you	want	to	copy.	You	can	click	and	drag	the	cursor	to
the	text	you	want	to	copy.	4	Copy	the	text.	Go	to	Edit	>	Copy	in	the	menu	at	the	top	of	the	screen.	You	can	also	use	a	keyboard	shortcut	and	press	Cmd	+	C.	5	Open	a	new	document	in	Word.	When	you	open	Word,	you	will	be	prompted	if	you	want	to	open	a	new	document	or	resume	a	created	earlier,	click	to	open	a	new	document.	You	can	also	go	to
File	>	New.	6	Paste	the	copied	text.	Press	Cmd	+	V	(Mac)	or	go	to	the	edit	menu	and	click	Edit	>	Paste.	You	should	see	the	text	from	the	PDF	appear	in	the	document.	You	can	also	right-click	the	page	and	click	Paste	in	the	drop-down	menu.	[1]	1	Go	to	in	your	favorite	web	browser.	This	will	open	your	Google	Drive	page	if	you	are	logged	in.	If	you	are
not	logged	in	to	a	Google	account,	enter	your	email	address	and	Google	password	before	proceeding.	Use	this	method	if	the	PDF	contains	encoded	text	as	an	image.	If	the	PDF	was	scanned,	it	was	probably	created	as	an	image	file	instead	of	a	text	file.	You	will	need	to	use	an	OCR	(Optical	Character	Recognition)	program	to	convert	the	image	to
selectable	text.	Google	Drive	includes	a	free	OCR	service	when	loading	PDFs	and	will	work	well	in	most	cases.	[2]	If	the	PDF	is	also	copied,	Google	Drive	can	remove	security	from	PDF	during	the	OCR	process.	2	Click	NEW.	It	is	a	multicolor	sign	more	in	the	upper	left	corner	of	the	Drive	page.	A	drop-down	menu	will	be	displayed.	You	can	also	drag
and	drop	the	file	from	the	file	browser	in	the	Google	Drive	window	to	upload	the	file.	If	you	do,	you	can	skip	the	steps	to	upload	your	file.	3	Click	Charge	File.	This	option	is	close	to	the	top	of	the	drop-down	menu.	Click	requires	a	new	window	to	open.	[3]	4	Switch	to	and	click	single	to	select	the	PDF	file.	Click	the	PDF	file	you	want	to	copy.	The	file
highlights	in	blue	to	indicate	that	it	is	selected.	5	Click	Open.	It's	at	the	bottom	right	of	the	window.	This	will	ask	the	PDF	file	to	upload	to	Google	Drive.	6	Right-click	the	uploaded	PDF.	Once	you	have	finished	uploading	to	your	disk,	you	will	need	to	find	your	PDF	and	right-click	to	launch	a	drop-down	menu.	7	Hover	over	Open	with.	This	option	is	close
to	the	top	of	the	drop-down	menu.	A	pop-out	menu	will	appear	next	to	it.	8	Click	on	Google	Docs.	This	will	require	Drive	to	runScanning	of	the	PDF	text	in	a	Google	Doc,	which	can	take	a	while	depending	on	the	amount	of	text	in	the	file.	9	Check	which	text	has	been	converted.	Google	Drive's	OCR	software	is	not	perfect,	and	there	may	be	some	errors
or	parts	of	the	text	that	could	not	be	converted.	You	can	encounter	a	lot	of	white	space	between	the	sections,	then	continue	to	scroll	to	see	everything	that	has	been	converted.	If	you	run	in	any	error,	consider	fixing	in	Google	Docs	docs	Copy	the	text.	10	Select	the	text.	Click	Edit	at	the	top	left	of	the	page,	then	click	Select	All	in	the	drop-down	menu.
You	can	also	use	a	keyboard	shortcut	by	pressing	CTRL	+	A	(Windows)	or	CMD	+	A	(Mac).	11	Copy	the	text.	Click	Edit	again,	then	click	Copy.	You	can	also	use	a	keyboard	shortcut	by	pressing	CTRL	+	C	(Windows)	or	CMD	+	C	(Mac).	12	Open	a	new	document	in	Word.	When	you	open	Word,	you	will	be	asked	if	you	want	to	open	a	new	document	or
resume	one	created	above,	click	to	open	a	new	document.	You	can	also	go	to	File>	New.	13	Paste	the	copied	text.	Press	Ctrl	+	V	(Windows)	or	Command	+	V	(Mac).	You	should	see	the	text	from	the	PDF	appear	in	the	document.	You	can	also	right-click	the	page	and	click	Paste	in	the	drop-down	menu.	1	Subscribe	to	the	free	trial	at	.	With	Adobe
Acrobat	Pro,	you	can	create	PDFs	and	export	to	Word,	Excel,	or	PowerPoint,	as	well	as	transform,	scanned	documents	to	editable	PDFs	and	searchable	for	14.9	/	month.	This	method	will	convert	the	entire	document	from	PDF	to	Microsoft	Word.	If	you	are	a	first	time	customer,	you	can	subscribe	to	a	free	seven-day	process.	You	will	need	an	email
address	that	is	not	connected	to	an	Adobe	account	to	qualify	for	the	process.	You	will	also	need	a	credit	/	debit	card,	but	you	will	not	be	charged	for	the	first	seven	days	you	use	Adobe	Pro.	Once	you	have	finished	enrolling	for	the	subscription,	you	will	have	the	opportunity	to	download	the	program.	2	Download	Adobe	Acrobat	Pro.	According	to
download	(Mac	VS	Windows),	you	will	need	to	follow	a	tutorial	on	the	screen	to	complete	a	configuration	wizard	or	you	will	need	to	drag	and	release	the	DMG	file	to	the	Applications	folder	in	Finder.	Once	completely	installed,	Adobe	Acrobat	Pro	can	automatically	launch,	or	you	will	need	to	open	it	manually.	To	open	Adobe	Acrobat	Pro,	double-click
the	app	icon	in	the	Start	Menu	or	Applications	folder.	3	Open	your	pdf.	You	can	click	File	at	the	top	left	in	the	edit	menu	above	the	document	(Windows)	or	at	the	top	left	of	the	screen	(Mac)	and	then	open	from	the	drop-down	menu.	4	Click	Export	PDF.	You	will	see	it	in	the	right	pane	at	the	extreme	right	of	the	application	window	with	a	document
icon	with	an	arrow	pointing.	You	can	click	to	check	the	box	next	to	"Open	file	after	export"	to	get	the	file	open	automatically.	5	Click	to	select	Microsoft	Word.	This	is	usually	the	first	option	here	and	you	usually	want	to	select	"Word	document"	from	the	right	panel.	6	Click	Export.	You	will	see	this	blue	button	under	your	export	selection.	[4]	7	Select	a
save	position	and	a	name	The	file	and	click	Save.	When	the	file	browser	opens,	you	have	the	chance	to	change	how	the	file	will	save	when	it	is	exported	before	clicking	Save	in	the	lower	right	corner	of	the	window.	[5]	If	the	PDF	has	been	scanned,	Adobe	will	automatically	recognize	the	text.	[6]	Ask	a	question	This	article	was	written	by	Darlene
Antonelli,	but.	Darlene	Antonelli	is	a	technology	writer	and	e	For	WikiHow.	Darlene	has	experience	with	university	courses,	writing	articles	related	to	technology,	and	working	hands-on	in	the	field	of	technology.	You	received	a	Master	in	Writing	at	Rowan	University	in	2012	and	wrote	his	thesis	on	online	communities	and	the	personalities	treated	in
these	communities.	This	article	has	been	viewed	40,130	times.	Co-Authors:	3	Updated:	1	November	2021	Visits:	40,130	Categories:	Convert	PDF	Printing	Documents	Send	the	email	to	fans	to	authors	Thanks	to	all	authors	to	create	a	page	that	has	been	read	40.130	times.	Times.
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